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Dear Sir / Madam,  

 

Thank you for choosing GCC and the JF-240UV Flatbed Printer. You can be assured that this 

machine meets the highest safety standards while using technological innovations shared by no 

other UV printer. JF-240UV Flatbed Printer is backed by GCC, a truly international company that is 

dedicated to help your business grow.  

 

We at GCC are proud to introduce the JF-240UV Flatbed Printer, our most technologically advanced 

UV printer to date. This easy to operate machine has been designed with quality, productivity, and 

safety in mind. With innovations like SmartMESHTM, patented color varnish, and outstanding quality 

with high productivity, the JF-240UV is clearly on the cutting edge of all UV inkjet systems.  

GCC understands that a creative technical background is the key to successful growth in the 

ever-changing information economy. We have a strong team of R&D experts who propel our 

company to new heights. From product development to manufacturing, our engineers are 

dedicated to innovation and quality.  

 

Guiding our solid technical base is a world-class management team. At GCC, our leaders bring 

together marketing, technical support, research development and distribution experts to create an 

international network to meet your demands. Over the years, this network has been able to span 

throughout the globe. Our technical support staff is committed to provide you with impeccable 

service, and when your business is ready to grow, our team will be there!  
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Release Note 

Version Change 

V.1 2016 Sep. 

Add Release Note page 

Add 6.9 Reset Pressure Gauge with Atmospheric Pressure 

Delete Chapter 7 and Chapter 8 (Optional items) 

V.1-1 2016 Nov. Re-organise chapter structure 

V.2 2017 Jan. 

Add 4.2 Time Locker (page 36) 

Add 5.2.10 How To Create Custom Pattern for Varnish Printing 

Add 5.3.6 5.3.6 How To Set Arc mode for Dome Shaped Braille Characters/Patterns 
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V.32017 Jun. Add 5.3.7 How To Create Raised Printing Effect 

V.4 2017 Aug. 
Rename printing mode, change from production mode to high speed mode. 

Add 5.3.8 How to set UV lamp Curing mode for bright color printing. 

V.5 2018 Jan. 
Removed wiper and ink sponge, capping sponge 

Add Chapter 6.7 Lubrication and Chapter 7 Caldera setup 

V.6 2018 May. 

Add QR Code 

Add 5.2.4 The adjustment value of brightness is not 0, hence, the value has 

been set to 0 as default 

Add 6.8 How to replace alignment rule 

 

V.7 2019 May 
Update FlexiPRINT GCC Edition V12 

Add 5.3.9 How to set CorelDraw for Spot White 

V.8 2019 Sep. 

Add specification of JF-240UV with blower 

Add How to upgrade your VLCD to the latest version 

Add JF-240UV Reference Parameter (For Foil Stamping) 
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Chapter 1 Introduction 

1.1 Warning 

These symbols are applied in the user manual for the safety precaution and to prevent equipment 

from damage. These symbols are informational notice. Please do understand meanings for each of 

these symbols and its related safety precautions prior operate the equipment. 

No. Safety label Graphic Content 

1 Warning 

 

The symbol indicates that fire is 

prohibited. The ink and the fluid 

discharged out are highly 

flammable. 

2 High Voltage 

 

The symbol indicates high 

voltage.  Remove the lid could 

lead to expose to high voltage or 

electric shock. 

3 Warning 

 

The symbol indicates that the ink 

is health hazardous.   

The ink and fluid discharged out 

is health hazardous, avoid body 

contact. 

4 Ink Leaking 

 

The symbol indicates to avoid the 

ink leaking.   

Turn off all valves of print heads 

before switching off the printer. 

5 Ground Wire 

 

The symbol indicates the 

machine should be grounded 

before conducting any 

maintenance or cleaning 

operation due to possible 

electrostatic discharge.   
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6 Printing 

Warning 

 

The symbol indicates that during 

the printing process do not put 

your hands in the printing area to 

avoid injury. 

7 Avoid Injury 

Warning 

 

The symbol indicates that during 

the printing process do not put 

your hands in the area to avoid 

your hands being pinched by 

moving parts.  

8 Keep Clear 

Warning 

 

The symbol indicates that do not 

put objects in addition to print 

media on the print area at all 

times to prevent print head being 

crashed by obstacles.  

9 Do Not Push 

Warning 

 

The symbol indicates that do not 

push carriage axis while moving 

the machine.  

 

1.2 Inks Safety Information 

Health Effects of Exposure to Ink 

Contact by Effect 

Inhalation 
Can cause severe respiratory irritation, dizziness, weakness, fatigue, nausea, 

and headache. 

Skin 
Can cause dermatitis or irritation that may last for hours or days, but 

unlikely to result in permanent harm. 

Eye 
Can cause severe irritation, tearing, and burns that may eventually lead to 

permanent impairment, including blindness. 

Swallow 
Can cause severe irritation to mouth, throat, and stomach, may further 

inflict abdominal discomfort, nausea, vomiting and diarrhea. 
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Disposal Considerations 

Waste ink contains hazardous substances. Do not dispose waste ink with household rubbish. Do 

not allow product to reach sewage system. Recommend to dispose waste ink according to official 

regulations. 

 

1.3 First-Aid Measures 

Contact by Remedy 

Inhalation Breathe in fresh air and consult a doctor in case of complaints. 

Skin 
Immediately wash with soap and water then rinse thoroughly. If skin 

irritation continues, consult a doctor. 

Eye 

First and for most, flush your eyes with plenty of water. Then, tilt your head 

to prevent chemical from transferring to the uncontaminated eye. Finally, 

seek immediate medical attention and monitor the eye as advised by your 

physician. Inform your physician that your eye was exposed to chemical ink. 

Swallow 
Do not induce vomiting. Drink copious amount of water or milk to dilute 

and breathe in fresh air, then, seek medical attention immediately. 

 

 

1.4 Personal Protection 

 

 

Protection Solution 

Respiratory 

Protection 
Ventilation may be required depending upon conditions of use. 

Skin Protection 

Avoid skin contact by wearing safety gloves.  Clean protective equipment 

regularly.  Then, wash hands and other exposed areas with soap and 

water before eating, drinking.  When leaving work, drink a lot of water. 

Eye Protection 

Wear safety glasses with side shields when handling ink to avoid the 

possibility of eye contact by slashing or spraying liquid.  Do not wear 

contact lenses. 
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1.5 Equipment Installation Precautions 

GCC JF-240UV shall be installed in a relatively clean, free from dust environment and the surface 

for the equipment to be installed shall be stable and flat. We suggest that you install the 

equipment in an air-conditioned environment to control the appropriate temperature and 

humidity. To ensure the equipment and the materials reach to the room temperature 24 hours 

prior in operation. For the environment shall meet following conditions: 

WARNING 

Prohibit on exposure under 

direct sun light 

Prohibit on setting up on tilt 

surface 
Temperature and humidity 

  

The operation environment 

for this 

equipment:  

22 to 30°C (71.6°F to 86°F) 

40% to 60% (humidity) 

 

 

 

Avoid locations with vibration 
Avoid locations with strong 

air current 
Avoid locations with flame 
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1.6 Ink Operating and Storage Environment 

Store the inks away from direct sunlight or other lighting sources, including fluorescent lighting. 

Store them away from acids, alkalis, and oxidizing material as well. Additionally, keep container 

tightly closed in a dry, cool, well ventilated place.  

The recommended ink storage temperature as following: 

* Temperature: 22°C to 30°C (71.6°F to 86°F). Humidity: 40% to 60%. 

Please do ensure the ink storage temperature and humidity. 
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Chapter 2 Equipment Main Body Introduction 

JF-240UV flatbed printer is designed for printing on rigid, cylinder and roll materials. Cylinder or 

roll materials are only available with the rotary attachment or roll to roll system optional items. 

JF-240UV Maximum material width: 610mm x 508mm (24" × 20") 

 

2.1 Flatbed UV Printer 

The innovative GCC Flatbed UV Printer can complete short runs and on-demand printing.  

Following the high quality of GCC products, the new GCC Flatbed UV Printer comes with high 

throughput, reliable printing preference, user-friendly interface, touch screen control panel and 

creative features. GCC Flatbed UV Printer accommodates standard four colors CMYK, and optional 

Varnish and White color that offer you the outstanding printing quality. 

In addition to the application for sign industry, like signage and signboard, GCC JF-240UV Flatbed 

Printer is dedicated to applications of custom items, including promotional items, décor, stickers, 

packages, personalized products and much more to fulfill all your needs.   

With applicable to a maximum of 30cm tall object and supportive to pass through printing ability, 

GCC JF-240UV Flatbed Printer eliminates the limitation of printing. Along with the optional 

roll-to-roll system and rotary system, users are allowed to work on a wide variety of applications, 

including flexible media, such as vinyl, wall stickers and heat transfer film to rigid material, such as 

acrylic, PC and foam board; furthermore, users can print preferred patterns on personalized items, 

such as phone cases, bottles, etc. GCC JF-240UV Flatbed Printer is the most suitable equipment for 

custom items with stunning quality. 
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2.1.1 JF-240UV Flatbed Printer Key features 

Features: 

1. Maximum print area: 610x508mm (24”x20”) 

2. Media thickness up to 300mm (11.8”) 

3. Print resolution of up to 1,440dpi  

4. Acceptable media weight up to 15Kg 

5. Maximum Print Speed: 5.78 m2/hr 

6. Auto Media Calibration (AMC™) 

7. Bundled FlexiPRINT GCC Edition RIP software 

8. Touch screen control panel 

9. Roll to Roll (Optional) 

10. Rotary Attachment (Optional) 

11. Dual LED lamp 

12. Pass through doors to accommodate long working objects 

13. Motorized Z axis adjustment 

14. High printing speed model is available, which can uplift two times printing speed of the 512 

print head model. 
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2.2 JF-240UV Appearance 

2.2.1 JF-240UV Front View 

 

 

 
                

 

 

 

 

 

 

 

 

H. Touch screen 

control panel 

D. Alignment 

ruler 

F. Bulk Ink supply 

system E. Front door 

G. Emergency 

stop button 

K. Print head set 

L. Front lid (Front 

hood) 

I. Waste ink 

bottle 

C. LED lamp 

A. Maintenance 

J. Printing area 

M. Toolbox 

 

 

 

B. Barometer 
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2.2.2 JF-240UV Rear view 

 

 

     

 

 

 

 

 

 

 

O. Fuse 

R. Ethernet 

Q. USB 

P. Power socket 

N. Rear door 

T. Side cover 

S. Power switch 
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2.2.3 JF-240UV Parts Description 

Parts Name Description 

A. Maintenance Maintain print head cleanness 

B. Barometer Ink pressure adjustment and display. 

C. LED Lamp LED Lamp for curing after printing 

D. Alignment Rulers Media can be aligned with the guide line marks 

E. Front Door Keep closed. Unless in necessary to open it up for loading the 

material. 

F. Bulk Ink supply 

system 

Where the bulk ink bottle are installed 

G. Emergency Stop 

Button 

Stop the machine under emergent condition. 

H. Touch Screen 

Control Panel 

Set and display JF-240UV printing settings. 

I. Waste Ink Bottle Waste ink area. When waste ink is full, please take down the 

waste ink bottle and dispose it. 

(Please follow the local regulations to dispose the waste ink to 

prevent contaminating the environment) 

J. Printing Area The area where JF-240UV conducts the inkjet printing. 

K. Print Head Set Printing graphic image 

L. Front Lid Keep closed to prevent eyes from being damaged by LED UV light.  

M. Toolbox Store commonly used tools. 

N. Rear Door Keep closed. Unless in necessary to open it up for loading the 

material.  

O. Fuse  3 Amp fuse to protect the circuits. 

P. Power Socket Hold the AC power cord. 

Q. Ethernet Provide network connection between JC-241UV and computer. 

R. USB USB connection. 

S. Power Switch Switch on / off the power supply 

T. Side Cover The side cover of JF-240UV 
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Chapter 3 Installation Procedure 

3.1 Machine Setup 

3.1.1 Turn On The Power 

Step 1 Please check the ink chip is inserted properly into the corresponding slot.  

 

Step 2 Fill each color of ink bottle with corresponding color of ink. It is suggested to horizontally 

shake the White ink 15 times before filling in the bottle or stir the White ink manually before 

printing. 

 

Step 3 Plug in the power plug and connect to the internet, then turn on the machine. 

Note: Please wait for 5 seconds to turn on/turn off the power if you need to restart the machine. 
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3.1.2 Set Ink Flow To Printer Heads 

Step 1 Remove the thumbscrew and open the left cover. 

  

Step 2 Open the ink valve. 

   

Ink valve is opened            Ink valve is closed 

Step 3 1. Entre FLATBED mode. 

2. Select MENU 

      3. Select MAINTENANCE 

      4. Select INK INSTALL/DRAIN 

       5. Select INK INSTALL FLOW 

 



                                           JF-240UV User Manual 

18 

 

Step 4 Ink install flow: 

1.Empty waste ink bottle.
2.Open the ink valves of print Head.
ENTER                                   CANCEL

       Start Ink Install Procedure?

ENTER     CANCEL 

Open the ink valves of ink bottle as 
shown
ENTER                                   CANCEL

Insert the chips of each color. Do not 
insert the chip of flush solution
ENTER                                   CANCEL

Make sure the chips of each color are inserted 
properly and the chip of flush solution is removed
ENTER                                   CANCEL

Seal the bottle caps
ENTER                                   CANCEL

Check ink level…

(YMCK) low ink level
Fill (YMCK) ) into ink bottles
ENTER                                   

Ink pumping
ENTER                                   CANCEL

The process is complete
ENTER                                  

adequate ink
inadequate ink

 

Step 6 Close up the left cover and fix it with thumbscrews.  
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3.2 Software Setup 

3.2.1 Softkey Installation Instructions 

Insert the DVD and run the installation and follow the instructions. Disable your antivirus software 

before installing FlexiPRINT GCC Edition.  

When the Install Manager dialog comes up, enter your password here: 

 

1.  Select "Open In Web Browser Now." 

 

2.  Select "I am new to the SAI Cloud", then select Create Account and click confirm 
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3. Select "Activate Now" 
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4. The FlexiPRINT GCC Edition is installed. 

  

 

5. Select "Yes,I want to restart my computer now." 
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Chapter 4 Control Panel 

This section mainly describes JF-240UV Flatbed Printer’s touch screen control panel, work flows 

and key operations.  

 

4.1 Control Panel Workflow 

Operating work flow: 

 

 

 



                                           JF-240UV User Manual 

23 

 

Control panel flow:  
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Operating work flow: 
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Control panel flow: 

 

 

 

 

 

 

USER SET 

 

AUTO CLEANING 

 

MANUL CLEANING 

 

POWER SAVE 

 

VACUUM 

 

INK REMAINIING 

 

MAINTENANCE 

 

SYSTEM INFO 

 

OPTION 

 

NETWORK 

 

RESTORE 

 

DEFAULT 

 

SET1 

 

SET2 SET3 

 

PARAMETER： 

AMC 

VACUUM 

LED POWER 

 

MANUL CLEANIING：YES 

 

NORMAL 

 

POWERFUL 

 

PASS TO WHITE CLEAN 

 

W CIRCULATION 

 

X：_______ 

Y：_______ 

 

 

PURGE 

 

PH GAP AUTO DETECTION 

 

NOZZLE CHECK 

 

X 

 

Y 
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Operating work flow:  
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Control panel flow:  

 

 

 

 

 

O N 

FRONT： 

REAR： 

O N 

O N 

OFF 

OFF 
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Operating work flow: 

 

 

Control panel flow: 

 

 

IP：192.168.102.249 

Sub Mask：255.255.255.0 

Gateway：192.168.102.250 

MAC Address： 

00：CF：52：72：03：01 

RESTORE DEFAULT：YES 

ON OFF 
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PAUSE while printing: Users can pause on the printing job by pressing the PAUSE button and 

proceed to cleaning procedure to improve printing quality. 

Operating work flow: 

 

Control panel flow: 
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4.2 Control Panel Layout Description 

Control Panel Layout Description 

Function Description Setting  Default 

Media sizing 

 

ROLL (Media Roll) 

Adjustment menu setup key for roll 

media printing settings (work with 

roll to roll system) 

Optional  

  

(AMC) 

Automatically detect 

the media height 

 

 

FLATBED 

Adjustment menu setup key for rigid 

media printing settings 

  

 

(LOAD MADIA) 

Set/Place media height 

  

 

(AMC) 

Automatically detect the media 

height 

  

 

(SmartPOSITION) 

Set printing area 

  

 

ROTARY 

Adjustment menu setup key for 

rotary attachment printing settings 

(work with rotary attachment) 

Optional  
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(LOAD MADIA) 

Set/Place media height 

  

 

(AMC) 

Automatically detect the media 

height 

  

 

 (ORIGIN) 

Set printing origin 

  

MENU→ USER SET 

 

USER DEFAULT/ 

SET1/SET2/SET3 

1) USER DEFAULT：Initial parameters 

settings 

2) SET1~3 parameter settings 

 (Adjust VACUUM/ BAND/AAS 

OFFSET/BI-UNI setting)  

Can store up to 3 

groups 

User DEFAULT 

MENU→  NOZZLE CHECK 

 

NOZZLE CHECK 

Perform print head nozzles checking   

MENU→ CLEANING 
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NORMAL 

Normal print head cleaning   

 

 

POWERFUL 

Powerful print head cleaning   

 

PASS TO WHITE 

CLEAN 

Purge white ink for print head cleaning 

after the defined printing passes are 

performed. Select PASS TO WHITE 

CLEAN can define the number of 

passes for white ink clean. 

  

 

WHITE CIRCULATION 

White ink circulation   

MENU→ MANUL CLEANING 

 

MANUL CLEANING 

When cleaning the print head 

manually, the cartridge will move to 

maintenance area on the left hand 

side automatically for cleaning. 

  

MENU→ POWER SAVE 

 

Automatically switches off the display 

of control panel when the device 

hasn't been used for a set period of 

time, allowable setting are 15 sec., 30 

 3 MIN. 
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POWER SAVE sec., 1 min., 3 min. and 5 min. 

MENU→ VACUUM 

 

VACUUM 

Vacuum function is to ensure 

material’s flatness. This setting can be 

enabled or disabled.  Default is 

enabled.  If choose disable, then 

there will be no vacuum sucking 

during the printing operation. 

 

ON/OFF OFF 

MENU→INK REMAINING 

 

INK REMAINING 

Check remaining ink volume 

* 99 means there is sufficient ink 

* 0 means short of ink, need to refill 

ink immediately. 

  

MENU→ MAINTENANCE 

 

REPLACE LED LAMP 

Automatically move the cartridge to 

the maintenance area on the left hand 

side for LED lamp replacement. 

YES YES 

 

REPLACE WIPER 

Replace the wiper YES YES 

 

REPLACE WASTE INK 

BOTTLE 

Replace waste ink bottle YES YES 
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INK INSTALL/DRAIN Ink-install flow 

Ink-drain flow 

  

MENU→ SYSTEM INFO 

 

SYSTEM INFO 

MODEL：Display the equipment 

dimension and model based on 

factory version settings 

FW：Display Firmware version serial 

number based on factory version 

settings. 

FPGA：Display FPGA version serial 

number based on factory version 

settings. 

INK ID FPGA：Display Ink ID FPGA 

version serial number based on 

factory version settings. 

ENGINE FPGA：Display ENGINE FPGA 

version serial number based on 

factory version settings. 

 

  

MENU→ OPTION 

INCH User can choose between Metric or 

Imperial measurement. 

Metric (cm, g) 

Imperial unit (inches, 

oz) 

Metric (cm, g) 

LANGUAGE SET LCM display language   
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MENU→ NETWORK 

 

IP ADDRESS 

IP address   

 

MCA ADDRESS 

MAC address   

MENU→ RFACTORY DEFAULT 

 

FACTORY DEFAULT 

Reset machine setting to factory 

default. 

 YES 

MENU→ PH GAP AUTO DETECTION 

 
PH GAP AUTO 

DETECTION 

Automatically detect the gap between 

print head and media. 

 ON 

MENU→ TIME LOCKER 
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TIME LOCKER 

Set the period of time that the 

machine can be operated. The Time 

Locker function can be used for hire of 

a machine to schools or organizations 

to manage the rent duration of a hired 

machine.  

 OPTIONAL 

PAUSE while printing Description 

PRINT LED LAMP→ 

 

LED LAMP 

Set LED Lamp Curing energy while 

printing 

ON/OFF ON 

PRINT CANCEL JOB→ 

 

CANCEL JOB 

Delete current print job  ON 

PRINT PAUSED→ 

 

NORMAL CLEANING 

Normal print head cleaning  ON 

 

POWERFUL 

CLEANING 

Powerful print head cleaning  ON 

 

When cleaning the print head 

manually, the cartridge will move to 

maintenance area on the left hand 

side automatically for cleaning. 

 ON 
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MANUL 

CLEANING 

 

WHITE CIRCULATION 

Circulation of white ink print head  ON 
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Chapter 5 Operating the JF-240UV 

5.1 Hardware Operation 

5.1.1 How to Set Flatbed Printing Mode 

NOTICE: 

The factory setting of the height between print media and print head is 1.5mm. 

If the height between print media and print head is more than 2mm, it may cause ink droplet 

misting or splashing and lead to a grainy and uneven printing.  

When the height between print media and print head is more than 2mm, the reflected light from 

UV curing lamp increases and it can cause the misting ink to be cured, increase the ink visocosity 

and nozzel clogging, and hence damage print heads.  

 

5.1.2 How To Set PH Gap Auto Adjustment Mode 

The PH Gap Auto Adjustment mode: 

It is suggested to set the settings to be “ON” (the default setting). Turning on the PH Gap Auto 

Adjustment mode provides the fastest way for users to start printing on the media of which the 

surface may be not flat or even, and the definite highest position of the media for AMC cannot 

easily be found. Also, it protects print heads from being scratched by automatically adjusting the 

print heads to optimized position when obstacle is detected.  

When the setting of PH Gap Auto Adjustment Mode is “ON”: 

If there is obstacle being detected, three steps can be applied, 

1. Cancel job: cancel current job and redefine the highest position of the media for AMC to obtain 

the best printing quality.  

2. Continue to print by the mode set in FlexiPRINT: The print quality may be decreased, because 

the print head gap is not the optimum value. 
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3. Continue to print by uni-direction: The throughput may be decreased and the quality may be 

slightly affected, because the print mode is forced to set to uni-direction and the print head 

gap is not the optimum value. 

Under the following conditions, the PH Gap Auto Adjustment Mode can be set to OFF for 

advanced users, 

1.  The media is flat or the highest position of the media for AMC is easily to be determined. 

2.  High print quality is high priority:  

The platen will not automatically be adjusted to optimized position and the print job will be 

canceled when obstacle is detected. The optimum print head gap defined by AMC is a critical 

element for printing quality especially when performing bi-direction printing. 

3.  High throughput is high priority:  

The laser beam scanning speed is faster when the setting is OFF than it is ON, and the default 

print mode (bi-direction) will not be changed for higher printing speed. 
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Workflow 

A. Set the “PH Gap Auto Adjustment” to be “ON” on control panel: (The default setting) 
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B. Set the “PH Gap Auto Adjustment” to be “OFF” on the control panel: 

 

 

 

 

 

 

 



                                           JF-240UV User Manual 

42 

 

5.1.3 How To Print On Rigid Material 

When the setting of PH Gap Auto Adjustment mode is “OFF”, refer to the following two 

exsamples for the instructions of rigid material printing: 

Example 1: Set parameter settings of full table print size 

Please load the rigid material correctly according to following steps. 

Step 1.  Entre FLATBED mode. 

Step 2.  Select MENU. 

Step 3.  Select USER SET. 

Step 4.  Select DEFAULT and select BACK icon . 

 

Step 5. Place print media on the lower right corner of the platen of JF-240UV. 

        

 (CAUTION)  

      



                                           JF-240UV User Manual 

43 

 

Step 6.  Select LOAD MADIA, and then adjust the height of platen of JF-240 to proper 

position.  

(Note: the printing side should always be adjusted BELOW the print head.) 

 

Step 7.  Select AMC to autamatically detect the height between print media and print 

head. 

(Note: It is suggested to apply AMC onto the highest position of the media.) 

 

Step 8. Send the file from FlexiPRINT GCC Edition RIP software, and printing is complete. 

 

Example 2: Set parameter settings of SmartPOSITION (define a diagonal as print size) 

Please load the rigid material correctly according to following steps. 

Step 1.  Entre FLATBED mode. 

Step 2.  Select MENU. 

Step 3.  Select USER SET. 

Step 4.  Select USER 1 and select BACK icon . 

(Note: Choose USER1/USER2/USER3 to save the settings of SmartPOSITION, so user can print on 

the same area without repeatedly setting) 

 



                                           JF-240UV User Manual 

44 

 

Step 5. Place print media on platen of JF-240UV. 

    

Step 6.  Select LOAD MADIA, and then adjust the height of platen of JF-240 to proper 

position.  

(Note: the printing side should always be adjusted BELOW the print head.) 

 

Step 7.  Select AMC to autamatically detect the height between print media and print 

head. 

(Note: It is suggested to apply AMC onto the highest position of the media.) 

 

Step 8.  Select SmartPOSITION. 

Step 9.  Press the Arrow Keys to move the 

cartridge to the lower right corner of the print material and then press Position 1 icon 

; then move cartridge again to the upper left corner of the print material and press 

Position 2 icon  

 

Step 10. Send the file from FlexiPRINT GCC Edition RIP software, and printing is complete. 
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5.1.4 How To Set IP 

Check the IP address of JF-240UV. 

Step 1 

 1. Select MENU on the control panel. 

 2. Select NETWORK 

   3. Select IP 

 

Step 2 Go to IP, select IP/Sub Mask/Gateway and adjust the value and select ENTER. 

 

Step 3 Go to Job Properties in FlexiPRINT Select VLCD in Printer Control and click Test Pattern. 
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Step 4. Start JF-240UV (VLCD) and click Open. 

 

 

Step 5. Enter the IP address acquired from the control panel in the “IP Address” column and click 

Save.  

 

 

 

5.1.5 Simplified Output Procedure 

Basic Output Message 

Please make sure test tuning / printing / quality / LED lamp are ok. 

Note: The tuning setting confirmation prior machine printing is very important; please double 

check to ensure they are correct. 

  Print             

Check Nozzle  v 

Check Bi-directional v 

Check Calibrate  v 

Check AMC v 
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5.1.6 Reset Back To The Factory Settings 

If messed up the parameter settings in the above operation, user can select from the control panel, 

follow the steps to reset back to the factory default. 

 

Step 1.  

 1. Select MENU on the control panel. 

 2. Select RESTORE DEFAULT. 

 

Enter RESTORE DEFAULT, select YES option then press ENTER to complete the 

restore to factory default settings. 

Note: YES to restore the factory default settings. 

 

5.1.7 Check Print Head Condition 

If the printing quality deteriorates during the process or daily operation, we recommend printing a 

print head test chart to make sure the print heads are defect or not.  If there is defect in the print 

heads, recommend cleaning up the print heads.  

 

Step 1 Perform NOZZLE CHECK 

  1. Select MENU on control panel 

 2. Select NOZZLE CHECK 
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 3. Set X and Y coordinates of NOZZLE CHECK pattern on the 

material and select CONFIRM. 

 

Step 2. JF-240UV will execute Nozzle Check automatically to ensure the print head quality. 

 

(Please refer to Chapter 6.3.3 and Chapter 6.3.4 for detailed instructions)  

 

If there is blocked pixel in print head, recommend to conduct following steps:  

Step 3. Conduct normal cleaning (Suggest for first time cleaning). If the problem persisted, please 

repeat the cleaning process. 

  1. Select MENU on the control panel. 

   2. Select CLEANING  

   3. Select NORMAL and the machine will proceed to NORMAL Cleaning. 
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Step 4. Conduct POWERFUL cleaning (when NORMAL cleaning does not clean throughout, it is 

suggested to conduct POWERFUL to clean up). 

  1. Select MENU on the control panel. 

 2. Select CLEANING. 

 3. Select POWERFUL and the machine will proceed to POWERFUL cleaning. 

 

Step 5. Conduct the printing test, to ensure the print head blocked problem has been solved. If the 

problem continues, please conduct the 2nd cleaning cycle. If the machine has been used for a long 

time, recommend to clean manually. 

 

5.1.8 How To Pause/Clean/Delete The Job While Printing 

When it is printing incorrectly or error occurs, it is suggested to use the PAUSE button on the 

control panel to stop printing. 

Pause while printing: 

Step 1.  Select PASUE on the control panel. 

Step 2. To resume the job, press  PAUSE button on the control panel again to continue 

the job. 

 

Clean while printing: (when cleaning print heads is required while printing)  

Step1: Select  PAUSE button on the control panel.   
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Step 2. LCM shows  

Step 3. Select NORMAL CLEANING, and press ENTER for NORMAL mode. 

Step 4. Select POWERFUL CLEANING, and press ENTER for POWERFUL mode. 

Step 5. Complete cleaning, select  RESUME to continue. 

 

 

Canceling job while printing 

Step1: Select  PAUSE button on the control panel. 

Step 2. Select CANCEL JOB on the control panel. 

Step 3. Press  ENTER again to cancel the job. 
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5.1.9 How To Set Pass To White Clean 

When PASS TO WHITE CLEAN function is turned on, the purge of white ink will be automatically 

performed after the defined pass is printed in order to keep the print head cleaning. 

Step 1 Select  MENU on then control panel 

Step 2 Select CLEANING 

Step 3 Select  PASS TO WHITE CLEAN 

 

Step 4 Complete 

 

 

5.1.10 How To Upgrade Your VLCD To The Latest Version 

Step 1 Go to Job Properties in FlexiPRINT and select VLCD in Printer Control, then click Test Pattern. 
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Step 2 Go to Print settings→Check engine board version and click Read to complete VLCD version 

upgrade. 
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5.2 FlexiPRINT GCC Edition Operation 

Recommended System Requirements 

Operating System： Windows 7, Windows 8, Windows 10 

RAM：4GB 

Install Space：700 MB for base program 

Working Disk Space：4 GB 

Other：Broadband Internet connection or Available port for hardware key and Available port for 

output device 

 

5.2.1 Basic Elements for FlexiPRINT GCC Edition 

Basic elements including: 

 

1. Classic Menu  

2. Toolbar  

3. Device Section   

4. Setting Section   

5. Operation Section 
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Toolbar 
Launch FlexiPRINT GCC Edition program.  The toolbar is the fastest way to browse through it. 

Launch “Toolbar”, right click on the blank section on the toolbar, then select the toolbar or content 

to be displayed. 

If you want to view the layout for the main page, please refer to the software basic elements. 

  Wizard Launch “Wizard” dialog box 

 

 Job Click on “Job” button to add job. 

Click on “Job” menu button to check on the quick menu. 

 RIP Click on “RIP” button to conduct RIP for the selected job. 

Click on “RIP” menu button to check on the quick menu. 

 Send Send the selected job to output to the output device, if necessary conducts RIP 

for it. 

 Estimate  Estimates the amount and cost of ink used in a job. Helps calculate the true cost 

of any print job. Can also prevent running out of ink in the middle of a job. 

   Nest     Nests the selected jobs together to use the minimum amount of the output 

media. 

  Unnest    Unnests the selected set of nested jobs. 

  Abort Abort the RIP process or output process for the selected document. 

 Delete Delete selected job or jobs. 

 Help  Click on “Help” button to open HTML help document. 

Click on “Help” menu button to check on the quick menu. 
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5.2.2 How To Setup For Printing and Import File 

Before starting Setup process, make sure the Ethernet cable is connected to your computer. For 

the installation of FlexiPRINT GCC Edition software, refer to Chapter 3.2. 

Step 1. Right-click on FlexiPRINT GCC Edition Icon and FlexiPRINT EDITOR Icon and select 

properties. 

  

Step 2. Select Compatibility and “Change settings for all users”. 

 

Step 3. Tick “Run this program as an administrator” and select “OK”.  
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Step 4. The settings is completed and open FlexiPRINT GCC Edition. 
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Step 5. From menu “Setup→Add Setup” setting to open up “Add Setup” dialog box (Short cut key 

Ctrl+N). 

 

 

Step 6. Select the output device model from the menu, select Hybrid Devices and select JF-240UV. 
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Step 7. After the new device is added, complete the operation. 

 

Step 8. Select “Add File→Add Job” (Short Cut Key Ctrl+O). 
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Step 9. At the “Add Job” window select the file name to be printed, and click Add to add the file. 

  

 

 

 

 

 

Step 10. The open file operation is complete. 
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5.2.3 Add Image Setting 

Add job (Short cut key Ctrl+O) 

The jobs can be transferred to the software via several channels.  

Add job through file 

1. Proceed with following operations:  

a. Select “Add Job” from the “File” drop menu. 

 

b. Click on the job menu button, and select add job from the quick men. 
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2. Select the file to be added. 

 

3. Select the options required: 

a. Select “Preview” to view the thumbnail for the selected file. 

 

b. Select “Copy to job folder” to copy the file to local working folder. 

* If job is stored in removable disk or network drive, you need to copy it to the local working folder, 

to continue operation when the storage device is removed or network is disconnected.   
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c. Select “Open job properties” to automatically launch “job properties” dialog box once the job is 

added to the “retention queue”.。 

  
 

4. From the settings list, select the settings that you want to apply to print the file. 

 

5. From the preset list, select the preset settings that you want to apply to the job. 

 

6. Click on the save, and name it as frequently used media parameters.  
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Select the preset options you want to save.  

 Save the default Layout tab value. 

 Save the default Color management tab value. 

 Save the default Color adjustment tab value. 

 Save the default Separation tab value. 

 Save the default Tile tab value. 

 Save the default Cut tab value. 

 Save the default Workflow tab value. 

 Save the default Printer options tab value. 

 Save the default Labels and marks tab value. 

 Save the default Object color control tab value. 

 Save the default Finisher tab value. 

 Save the default Step and repeat tab value. 

 

7. Completion. 

 

Selecting Setups 

To select job, please click in the job list to select it. 

Use standard Windows operation, combine CTRL and SHIFT key to select multiple jobs : 

˙ Hold the CTRL key to select multiple independent jobs. 

˙ Hold the SHIFT key to select the first job and the last job to select a range of jobs. 

To select all jobs, please click the select all in the Edit menu. 
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Deleting Setups 

To delete jobs, please execute the following steps : 

˙ Select the Delete or Backspace key in the keyboard. 

˙ Select the job, and select the delete from the Edit menu. 

˙ Select the job, and click the delete button in the toolbar. 

˙ Right click on the job, and select the delete from the pop up menu. 

 

5.2.4 Editor 

Layout Tab 

The Layout tab controls how the job is positioned on the output media, what size it is and the layout 

of the output. 

 

Media Size 

adjustment 

area 

Image size 

setting area 

 

Position setting 

 

Copies  

 

Image setting 

for rotate and 

mirror 

 

Media Sizing 
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Media Size   The size of the media loaded into your output device. Select from one of the preset 

sizes, or specify unique dimensions below. 

        The width and height of the media. 

 The margins of the printable area. 

         Media sizing: When you specify a set of custom dimensions, it is automatically added 

to the list of preset sizes. 

 

Job Size  Editing these options allows you change the output size and  

            orientation of the page. 

  The width and height of the job. 

  The width and height of the job as a percentage of the original. 

 

Fit to Media   Scales the job proportionally so that it is as large as possible while still fitting within 

the printable area of the output media. 

Proportional  Increases or decreases width and height together to keep the original proportions 

intact. 

 

Position      Changes the position of the job on the media. 

 The distance between the job and the right and bottom margins of the 

printable area. 

 Places the job at the specified distances from the lower and right edges of 

the printable area of the output media. 

 Centers the job along the width of the printable area. 

  Centers the job in the middle of the printable area. Only available for sheet 

material. 

  Places the job at the specified distances from the lower and left edges of 

the printable area of the output media. 

 The number of copies to be output. 
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 The amount of space between the various tiles, copies and/or nested jobs that 

are output as part of the job. 

 

Page Range  Specifies the range of pages that are output for a multi-page job. Format 

is x-y. Also accepts “,” to put in multiple ranges. 

Ex:  5  Prints page 5. 

    2-5  Prints pages 2, 3, 4 and 5. 

    3, 5-10  Prints pages 3, 5, 6, 7, 8, 9 and 10. 

 

 

Page Nesting  Check to automatically nest pages, tiles and separations of the job. 

 

Flips the selected image on the vertical axis, so that the image is mirrored when printed. 

Rotates image on the media in 90-degree increments. Click the button until you 

achieve the desired orientation. You can also rotate a job in 90° increments by 

selecting it in the Preview Area and clicking its center rotation handle. 

 

Workflow Tab 

The Workflow tab displays settings related to the time and order that the job is processed in. 
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After output Sets what to do with the job after output. 

Delete  Removes jobs from the queue after output. 

Hold      Places jobs in the Hold Queue after output or at the bottom of the 

queue. 

 

Send        Sets what part of a combination print and contour job will be output.  

Print only Only the printed part of the job will be output. 

 

Repeat Job    Enter the number of times you would like the software to automatically re-send the 

job. 

* This feature saves you from having to manually send the job each time you want 

to output it. 

 

Color Management Tab 

The Color Management tab displays the settings related to the printing device. The layout of this tab 

may differ depending on the output device. 
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Color Correction  Select the desired type of color correction. 

  Use color correction Activates the color correction settings from the 

selected ICC Profile 

 Use only linearization Activates the linearization settings only from the 

selected ICC Profile. 

No color correction The software uses a generic CMYK profile, instead of a 

profile generated from actual color measurements of 

output from the device. Orange and green inks will not 

be used 

 

Output profile  Select a profile from the list or select Add to add an ICC profile. 

 

Media   Select the media type the output is printed on. 

 

Resolution Select the output resolution. The setting may differ according to different 

output device used. 

1. High Speed Mode: 720 x 1,440 dpi, 

2. Quality Mode: 720 x 1,440 dpi, 

3. High Density Mode: 1,440 x 1,440 dpi. 

Outputting mode settings: The higher the value is the better the quality is, but 

the longer the outputting time will be. 

 

Color Mode Select the color mode that matches the inks set in the printer. 

CMYK The image prints using a combination of cyan, magenta, yellow and black 

inks. 

 

Dither        Select the dithering for the output. 

Dither Type is the pattern in which the individual dots that make an image are 

applied to the media. Each dither type has advantages in terms of quality and RIP 

speed. The default dither type is usually the best setting for your machine. 

The software offers several dithering options to optimize your output. Usually, 

quality and speed are a tradeoff, with KF Diffusion offering the highest quality and 

the LX Diffusion or FMXPress offering the fastest processing times. 

The available patterns (in descending order of quality) are: 

          1. SO Diffusion 

          2.Error Diffusion 
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          3.Error Diffusion2 

          4.FMXPress 

          5.KF Diffusion 

          6.Random Diffusion 

          7.LX Diffusion 

          8.Angle Screen 

Description：1. SO Diffusion  

            SO Diffusion is the default diffusion method for all newly created profiles. It 

eliminates banding and produces the smoothest gradients and most vibrant and 

accurate output of any other diffusion method. SpotON RIP speeds are slightly 

slower than FMXpress, but yield higher quality output. 

          2.Error Diffusion 

            Produces high-quality images. The enhanced image quality requires intensive 

processing (3-4 times more than FMXPress), and the time it takes to RIP a file 

using this method is the second longest of the available options. 

          3.Error Diffusion2 

          4.FMXPress 

            The default diffusion method. It's the fastest in terms of RIP time and is suitable 

for most prints. 

          5.KF Diffusion 

            An enhanced version of the error diffusion method. While it takes longer to RIP 

(5-6 times more than FMXPress), it provides the highest detail and contrast for 

most inkjet printers. 

          6.Random Diffusion 

            Provides a balance between image quality and RIP time. It takes 2-3 times longer 

than FMXPress. 

          7.LX Diffusion 

            A faster option, as far as RIP times are concerned. It is best used for large prints 

that are viewed from a considerable distance. 

          8.Angle Screen 

            Designed for use with thermal printers to produce vibrant, saturated colors. This 

is also produces screen print positives. Click Edit to set advanced options. 

 

Gradient Smoothness Select Normal, Enhanced or Super. The higher settings cause the software 

to render gradients using more elaborate algorithms that produce 

smoother dithering. 
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Use color mapping Check to print spot colors based on settings in global and custom color 

mapping. Click Color Mapping to set custom color mapping options. 

 

Ignore overprint  Ignores any overprint settings that may exist in jobs it outputs. 

 

 

Printer Options tab 

The Printer Options tab displays driver settings related to the selected output device. Every output 

device supports different driver options. 

 
Printer Control   Print out the test pattern for VLCD,Nozzle Check, Head Angle, Color Offset, 

BiDirectional Offset, Band Offset, AAS Offset              

 

Direction        Select the type of print direction you want your output device to use. 

                Unidirectional   The print head prints in one direction to ensure precise 
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alignment. 

Bidirectional    The print head prints in both directions to increase the speed 

of printing while sacrificing precise alignment. 

 

 

 

 

Tiling and Cropping Jobs 

The Tiling and Cropping Jobs shows the settings that related to output device. The setting options 

may differ according to different output device. 

 

The tiling feature of the software allows you to split a print job into a number of smaller tiles that 

are then output separately.  

When you rotate or resize a job, all tiling is removed. If the job is larger than the output media after 

it rotates, it will automatically be retiled. 

* If a job is larger than the output media, it automatically tiles into pieces small enough to output. 
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Panel size     The panel splits the job into tiles and is output by the software. If the panel reduces 

in size so that it does not cover the entire job, only the parts covered by the panel 

are output. 

  Shows the width and height of the panel. To adjust, enter a number or use 

the spinner controls. 

    The size of the margin. The margin is the part of the panel that extends 

outside of the boundaries of the job. 

 

Selected tile   Selects which tile's width and height display in the fields below. 

 Selects a tile to edit. The selected tile highlights in the preview pane. 

 Shows the width and height of the selected tile. To adjust, enter a number 

or use the arrows. 

 

Print      Check to output the selected tile with the rest of the job.  

  Clear to prevent output by marking the tile with a mesh overlay in the preview pane 

 

All tiles   These settings apply to all tiles and help you quickly set up automatic tiles of equal size. 

    Selecting this option divides the job vertically into the number of columns 

specified. Each column is of equal width. 

    Selecting this option divides the job into the number of rows specified. Each 

row is of equal height. 

  Enter the values for the width and height of the tiles here. All tiles change to 

the specified size. 

 Set the amount of overlap between tiles. Enter a negative number to create an 

offset between tiles. 

 

Reset     Restores the default settings. 

 

Automatic tile flip Check to rotate every other printed tile 180° so that adjacent vertical edges 

always print with the same side of the print head. This helps them match up 

cleanly. 
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Dividing a Job into Uniform Rows and Columns of Tiles 

1. Check the  or  fields to tile the job vertically or horizontally into evenly divided columns 

or rows 

2. Set the  fields to the desired width for the tiles. 

3. Set the  fields to the desired height for the tiles. 

4. Set the amount of overlap between the tiles in the  field 

  

 

Dividing a Job into Uniform Tiles of a Specified Size 

1. Check the  and  fields to set all tiles in the job to be of the specified size. 

2. Set the  and  fields to the width and height desired for the tiles. 

3. Set the amount of overlap between the tiles in the field. 

  

* If the specified tiles do not cover the job evenly, the tiles at the top and right edges are made 

small enough to fit in the gap.  
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Selecting a Tile 

To select a tile, either click the tile in the preview pane, or select the tile using the  field in the 

Selected tile section of the Tile tab 

 

Editing Tiles  

To edit the size of the selected tile, change the values in the  and  fields. 

You can also resize tiles by dragging their edges in the Preview Pane. 

  
Click and drag to resize. 

If any of the All Tiles checkboxes are checked, the  and  fields may be disabled. In this 

case, the fields have been overridden in order to keep all tiles uniform. The tiles will not be editable 

using the Preview Pane either. 

 

If you drag the edges of the panel over so that part of the job is exposed, a new tile will be created 

to cover the exposed area of the job. The exception to this is if you resize the panel using the 

cropping handles. 

  
Click and drag the edge of the panel to add another tile.  
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Labels and Marks Tab 

You may choose to print crop marks and information about the job along with any notes that you 

enter. 

 
Color   Select the ink that is used to print labels and marks. 

Width   Sets the width of the labels. 

Print Marks Adds crop marks or color block on the corner of print job to define where the 

page should be trimmed or the job property. 

Tile overlap lines  Lines on tiles print to indicate where the edge of the overlap is. Use these to 

align the tiles.  

If you check On both tiles, the overlap lines appear on both tiles. If not, the 

overlap line only appears on the second tile. 

  

 

Print color bands: check this item allows you to print the color bar on the selected image. 
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Color Adjustment Tab 

Note：The adjustment value of brightness is not 0, hence, the value has been set to 0 as default 

The Color Adjustment tab provides some basic tools to manually adjust the output color. 

Each color channel is listed separately as a linearization curve that determines what percentage of 

coverage is used (output) for a specified percentage in the original image (input).  

   

Preview   Shows the changes in your color settings reflected in the preview pane. 

Channel   Select the color channel you want to edit. 

Output    The value for the point that is selected on the linearization curve. 

• Click on the curve to select a different point to edit. You can also select a point by 

clicking on the input axis label. 

• To change the value at a given point on the curve, edit the value in the Output field, 

or click and drag the point up or down. 
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Contrast   Adjusts the amount of contrast in the image. 

          This setting is only available when All color channels are selected. 

Vividness  Adjusts the vividness of the image. Higher settings boost color saturation and 

brightness at the expense of color fidelity and detail. Lower settings decrease color 

saturation and brightness, but increase contrast. 

This setting is only available when All color channels are selected. Also, you must have 

an ICC profile selected in the Color Management tab. 

          

 Click the Variations button to open the Variations dialog. See Working with Variations 

 

Separations Tab 

The Separations tab contains a number of options related to printing color separations. 

 

Print as separations     Check to print each color plane separately.  
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To print separations for certain colors only, clear the checkboxes for the 

colors you do not want to print. 

Print separations in color   Makes each process color separation print in the appropriate color of 

ink. If you do not select this option, all process color separations will 

print in black. 

* Separations for spot colors will always print in black. 

Editing Color Channel Details  Select Channel Details to edit the output setting for each color 

channel. 

* If the Print as Separations box is checked, but Print separations in color is not checked, you can 

select how the separations for each color channel are output by selecting the desired color channel 

and clicking Edit. 

 

 

Setting the Preview Pane View 

“Preview Pane View” only shows the basic settings. 

To set the “Preview Pane View”, please single-click the “Preview Pane View” button in the window. 

 

Basic settings are in the left hand side of the window whereas a preview window on the right hand 

side shows the printing quality of output materials. 

 Allows job selection or reposition in the preview window.  

   Doubles the size of the object. Single click points will become the view center.  

           • Pressing Ctrl and single-clicking this tool will diminish the object by half. 
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• Single click points will become the view center. 

           • Single click and drag any sections you would like to enlarge. 

   Scale the image to fit the view window.  

Set default preview pane 

Select one of the three available views from the list at the top of the preview pane. 

 

Page preview     

 

 

 

Layout preview      

 

 

Tiling Preview      

 

 

 

 

Display each page of the job scaled to fill the preview area. 

If there is more than one page in the job, a list of the page numbers will 

appear above the preview, allowing you to select the page to display. 

* If you are using FlexiPRINT, only the first page is displayed in Page Preview. 

** This option will be selected automatically when the Workflow, Color 

Management, Printer Options or Color Adjustment tab is selected 

Display the job as it will appear on the output media. The preview is scaled 

so that the output media fills the preview area. 

* This option will be selected automatically when the Layout, Labels or 

Separations tab is selected. 

 

Display the job broken up into tiles to show how it will look when output. 

* This option will be selected automatically when the Tiling tab is selected. 
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5.2.5 External Software Printing Setups 

Adobe Illustrator Windows 

Color printing 

1. Select “Document Setup” from the Adobe Illustrator “File” pull down menu : 

a. Select “Artboard” from the pull down menu: 

i. Select a standard sheet size from the Size field. 

ii. To use customized sheet size: 

(1) Select “Custom” from the Size field. 

(2) Select the required “Units”. 

(3) Enter the “Width” and the “Length” for the customized sheet size. 

* To avoid from truncating image, please enter the accurate media size. 

(4) Click on OK. 

 

2. Select “Print” from the “File” menu. 

a. Set the Name settings to the network printing queue corresponding to the required output 

device. 

b. Set the Copies as the required duplication. 

c. Click on the Properties button. 

d. Select Layout tab, and click on the Advanced button. 

i. For the Advanced Options : 

(1) To print the file automatically, please set the “After Spooling” as “Print”. 

(2) To verify the print mode and profile settings, please set the “After Spooling” as “Hold”. 

(3) To start the RIP but without carry out the printing, please set the “After Spooling” as “RIP”. 

(4) Click on OK. 

ii. Click on OK. 

iii. Click on OK to start the printing. 
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CorelDRAW  

1. Select “Print Setup” from the “File” menu in CorelDRAW. 

a. Select printer from the “Name” field. 

b. Click on the “Properties” button. 

i.  Select sheet size from the “Paper” field, or select “Custom Page” to use user defined 

sheet size. 

 * According to the operating system and driver, it could be required to click on the 

“Advanced” button to select the sheet size. 

ii.  To use customized sheet size: 

(1) Select “PostScript Custom Page Size” from the Size field. 

(2) Select the required Units. 

(3) Enter the Width and the Height for the customized sheet size. 

(4) Click on OK to leave the Advanced Option dialog box. 

iii.  Click on OK to leave the Properties dialog box. 

c. Click on OK to leave the Print Setup dialog box. 

2. Select “Print” from the File menu. 

a. Set the Name setting to the network printing queue for the required output device. 

b. For the General tab : 

i. Set the “Print Range” settings as to the page range to be printed. 

ii. Set the “Number of copies” settings to the duplication to be printed. 

c. On the PostScript tab : 

i. Select PostScript3 compatible. 

d. On the Miscellaneous tab : 

i. Select one of the following methods to output the bitmap as CMYK: uncheck the 

“Output Bitmaps in RGB”. Set the “Output Color Bitmaps as” settings as CMYK. 

 * According to the actual operating system and driver version, the settings might show 

up in somewhere else. 

ii. Ensure uncheck the “Use Color Profile”. 

 * According to the actual operating system and driver version, the settings might name 

as “Apply ICC profile”. 

3. Click on the Print button. 
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Spot Colors Printing 

1. To assign spot colors to be applied on the output design component: 

2. Select “Palette Editor” from the Tool menu in CorelDRAW. 

a. Add spot colors definition: 

i.  Select “User Defined Inks” from color palette drop down list on the top of the dialog box. 

In CorelDRAW X3 and X4, it is “Custom Spot Colors”. 

ii. Click on “Add Color”. 

iii. Select “Models” tab, and select the color to be used as the spot color on the screen. 

* At this moment, no need for entering the name for the color. 

iv. Click on “Add to Palette”. 

v. Repeat the process for all the other colors to be added as the spot colors. 

vi. Click on the “Close” button. 

b. Edit Spot Colors: 

i.  Select the colors which are added to the Palette Editor. 

* They will use the default name, such as Ink (1). 

ii.  Change the color name in the “Name” field in the “Selected Palette Color”. 

* To make it function normally, the name must be mapped to the name in the “Spot 

Colors List”.  

 

 

5.2.6 JOB Server Settings 
 

JOB Server is a feature to configure a print server that allows several computers sharing the network 

to send and print documents utilizing the same printer.  

 

1. Add GCC JF-240UV printer driver and tick “Yes, install the desktop driver”. 
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2. Go to Start from the taskbar and select Devices and Printers. 

 

 

 

3. GCC JF-240UV_1 printer server is shared on the intranet.  
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4. Then use anther computer to connect the shared printer.  

Go to Start menu from the taskbar and select Devices and Printers and click Add a printer.  

 

 

5. Select Add a Network, wireless or Bluetooth printer and choose JF-240UV from the printer list. 

The JF-240UV printer will be added. 
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6. Open Illustrator, go to Print under File from the menu bar of Illustrator.  

 

 

7. Select GCC JF-240UV_1 from the Printer drop down menu and click Setup. 
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8. Select Advanced… 
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9. Set After Spooling: Hold under Printer Features and click OK. The JOB Server setting is complete. 

The print mode and parameter setting can be set in FlexiPRINT.  
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5.2.7 How to User Auto Serialization in FlexiPRINT GCC Edition-ADVANCED 
 

Step1 Create or import a name card design in FlexiPRINT GCC Edition. 

 
 

 

Step 2 Create Database of name card in a spreadsheet 
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Step 3 Save the EXCEL file as .txt file 

 

 

 

Step 4 Use text tool to add texts to the name card design  

(Note: The input text need to be the same as the text in the cell of the spreadsheet). 
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If you want to add variable QR codes, please follow step 5~8. 

Step 5 Use text tool to add texts to the name card design (Note: the input text need to be the same 

as the text in the cell of the spreadsheet) 

   

 

Step 6 Select the text and go to Text→QR-Code→Text to QR Code to convert the text to QR code. 
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Step 7 Select Type: Web URL in DesignCentral window (the DesignCentral window should be located 

in the toolbox on the right side). 

 

 

Step 8 Drag the QR-Code to the desired position. 
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Step 9 Select all the object in the name card design. 

 

 

 

Step 10 Go to Arrange→Auto Serialization 
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Step 11 Click Browse… to import the txt file and select all the “Select text to be replaced” section 

(The “Select text to be replaced” section allows you to decide which information on the name card 

to be replaced). 

 
 

Step 12 Click Next 
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Step13 Click Finish 

 

 

Step14 Auto Serialization is completed. 

 

 

10. Click Preferences 
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5.3 How To Set The color-white/white-color/color-white-color 

printing 

JF-240UV offers four major utilizing white ink applications to meet the demand in the marketplace, 

as a base, overcoat, spot color and three layer printing. With the White solution, it can be easily 

used to produce brilliant and rich color output on any transparent and dark media, offering 

excellent quality images to fulfill all needs of for Promotional item, Specialty, Sign, Labeling and 

Packaging industries. 

 

Dedicated white ink can fulfill four major applications: 

1) White as a Base (white-color)                  2) White as a Spot Color  

          

 

3) White as an Overcoat (color-white)           4) Three layers printing (Color-white-color)  
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5.3.1 How To set Illustrator for color-white/white-color/color-white- color 

printing 

1. Open the Illustrator and load the image 

  

 

2. Add a new color swatch (Set the new color name to be Spot_White and the Color Type to be 

Spot Color) 

  

 

 

3.  Fill Objects with Spot White Swatch and overprint. 
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4.  Save as EPS format 

 

    Tips: Preserve the overprints Select the PostScrip Level 3 

 

5. Add the EPS file to FlexiPRINT GCC Edition. 

 

6. Go to Color Management page under FlexiPRINT, and choose ICC under output profile and 

un-tick “Ignore overprint” 
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7. Go to Printer Options page, select “Spot color” and “Underneath” (white-color) or “Overlay” 

(color-white) in the drop-down menu in Spot_White section. 

 

The definition of the options of Spot_White/Spot_Varnish drop-down menu: 

Spot: fill the user defined area with white/varnish color  

Substrate: fill the entire file with white/varnish color 

Under Color: fill colored area with white/varnish color 

Fill color: fill the entire file except colored area with white/varnish color 

8. Go to Separation page, select Spot_White and press send. 

 

9. Flexi PRINT will open Spot Colors Settings window, tick “White Ink Percentage” or “Multiple 

Layers” and set white ink volume, and then press Save. The settings is complete. 
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5.3.2 How To Set FlexiPRINT Editor for color-white/white-color/ 

color-white-color Printing 

1. Open the PhotoPRINT Editor and load the image. 

  

 

2. Create a spot white in Editor 

Open the color specs: 

  

Create a New color 

Tips: it is suggested to use 

White Ink Percentage for the 

coverage of a large print area 

while Multiple Layers can be 

used for raised patterns 

printing. 
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Set the name to be Spot_White and the mode to be Spot. 

  

3. Fill Objects with Spot White Swatch and overprint. 
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4. Select Rip and print 

     
 

5. Set the send mode is Hold list and send it 
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6. Refer to step 6 ~ step 9 in “How to set FlexiPRINT GCC Editor for 

color-white/white-color/color-white-color” to complete the settings.  

 

 

 

 

 

 

 

 

5.3.3 How To Set Varnish Printing 

Varnish is a transparent spread on the surfaces of printed matters (images) that forms a thin and 

even transparent gloss layer after its leveling and UV curing for drying process. Varnish protects 

printed content, enhances durability and raises the value-added of products as it creates a gloss 

effect on specific parts of printed matters. 

Note: When setting varnish printing, please make sure the pinch rollers of machine above the 

material are released. 

 

Create a file in Illustrator: refer to “How to set FlexiPRINT GCC Editor for 

color-white/white-color/color-white-color” and set the name Spot_Varnish. 
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Create a file in FlexiPrint GCC Editor: refer to “How to set FlexiPRINT DX Editor for 

color-white/white-color/color-white-color” and set the name Spot_Varnish. 

 

 

1) Go to Color Management page under FlexiPRINT GCC, choose ICC under output profile and 

un-tick “Ignore overprint” 

 

Spot_Varnish 
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2) Go to Printer Options page, select “Spot_Varnish” and “Overlay” (varnish coating over color) 

in the drop-down menu in Spot_ Varnish section. 

 

 

3) Go to Separation page, select Spot_Varnish and send it to Flexi PRINT. 

 

 

4) Flexi PRINT will open Spot Colors Settings dialog box 

1. Set ink volume in the drop-down menu in Ink Percentage 

2. Select the pattern listed in Mark Name column you want to print with varnish and press 

save to complete. 
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Five gloss effects  

Gloss: The graphic is made to be glossy 

Semi gloss: The graphic is made to be semi glossy 

Matte: The graphic is made to have a matte surface 

Water mark: The graphic is made to be glossy with watermarks 

Super glossy: The enhanced glossy effect on graphics 

 

Color Mixer: 

By adjusting the spray printing control of color inks and varnish inks, JF-240UV is able to apply color 

varnish to printed matters. This advanced technology is an excellent helper of color customization 

and fully exhibits the promoting effects and practical value of the combination of varnish and 

patterns on printed matters (images) protection and enhancement. 

 

5.3.4 How To Create Custom Pattern for Varnish Printing 

Users are allowed to use graphic design software to create a preferred pattern and apply it for 

varnish printing to produce unique effect on the print media. Follow the steps to create a custom 

pattern for varnish printing. Microsoft Paint is used as an example here.  
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1. Open Paint, go to File under Properties.  

 

2. Select Pixels in Units column and set Width/Length value. The Width/Length value must be a 

multiple of 8, i.e. 8 x 8 or 160 x 160 pixels  

 

 

 

3. Create a desired pattern.  
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4. Save the file as .tiff format and .jpeg format.  

 

 

5. Save the .tiff file to the location C:\Program Files (x86)\FlexiPRINT 10.5.1 GCC 

Edition\Program\GCCJF240UV\TestPattern\Varnish\Mark 

 

6. Save the .jpeg file to the location C:\Program Files (x86)\FlexiPRINT 10.5.1 GCC  

Edition\Program\GCCJF240UV\TestPattern\Varnish\Preview 

 

7. The custom pattern for varnish printing is complete. 

 

 

 



                                           JF-240UV User Manual 

108 

 

Step 1 Open the “GCCVarnishControl” file folder from the installation disc and click 

GCCVarnishControl.exe 

 

Step 2 Click “Add Image” and select the file you want to use to create the varnish pattern. 

 

 

Step 3 Name the file in Mark Name and click Set. 

 

Step 4 GCC VarnishControl will generate the pattern automatically.  

 

Step 5 Click “Create Pattern” to save the varnish pattern. The pattern file will be saved to the 
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default location GCCVarnishControl\TestPattern\Varnish 

 

 

Step 6 Copy the “Varnish” file folder and paste it to the location C:\Program Files 

(x86)\SAi\FlexiPRINT 12 GCC Edition\Program\GCCJF240UV\TestPattern\Varnish 

 

 

Step 7 The process is complete. 
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5.3.5 How To Set ADA Sign (Braille Sign) Printing 

Multi-layer printing technology is the best tool for ADA sign (Braille sign) applications. 

The thickness of a layer printing in white is around 0.5mm and can reach a maximum of 0.8mm 

thick by multi-layer printing. The required thickness of ADA sign (Braille sign) varies according to the 

regulation in different countries. Apply proper ink percentage to perform multilayer printing to 

reach the wanted thickness and produce ADA compliant signage. 

1. ADA Sign (Braille Sign) 

ADA sign (Braille sign) is a system printed as raised dot that can be read with the fingers by visually 

impaired people. Braille is not a language, but a code by which many languages—such as English, 

Spanish, Arabic, Chinese, and dozens of others—may be written and read. Braille is used by 

thousands of people all over the world in their native languages, and provides a means of literacy 

for all. 

Derivation (colored dots) of the 26 letters of the alphabet from the 10 numeric digits (black dots) 
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2. ADA (Braille sign) Dimension 

 

3. Insatll Braille Font for Printing 

Step 1 Insert the installation disc and go to :\Program Files (x86)\FlexiPRINT 10.5.1 GCC Edition 

E14-29 Usb\Program\GCCJF240UV 

Step 2  Double click the "braille" icon to install the font. 

4. How to Set ADA/Braille Printing 

If creating Braille sign in Illustrator or CorelDraw, set the font type to Braille at 24pt to meet the 

requirements set by the ADA (Americans with Disabilities Act); if using FlexiPRINT EDITOR or 

other software to create Braille sign, apply the following steps,  
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The required dimension of braille sign differs according to the regulations in different countries. To 

meet various requirements, users can manually define the height of a cell to create the sign that 

complies with local regulation.  

The formula for the calculation of the height of a cell is (b x 2) + e, where b means “Vertical dot to 

dot (mm)” and e means “Dot base diam. (mm)”, as shown in the table above.  

Take an example of how to calculate the height of a cell based on American Standard Sign:  

According to “American Standard Sign”, the value of b is between 2.3mm to 2.5mm, defines a value 

of b as 2.5mm; the value of e is between 1.5mm to 1.6mm and defines a value of e as 1.6mm, then 

applies the values of b and e to the formula to get the result: 

b = 2.5 mm, e = 1.6mm; formula (b x 2) + e = (2.5 x 2) + 1.6 = 6.6 (mm) 

Step 1 Set cell height to 6.6mm in DesignCentral window in FlexiPRINT GCC EDITOR. 

 

Step 2 Refer to Chapter 4.7.2 “How to set FlexiPRINT GCC Editor for color-white/white-color/ 

color-white-color” to complete the settings.  

Step 3 Under Spot Colors Settings window, tick “Braille Sign” and select the dot height from the 

drop down menu and press Save. The setting is complete. 
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5.3.6 How To Set Arc mode for Dome Shaped Braille Characters/Patterns 

Printing 

Braille is a coded system of tactile raised dots organized into cells consisting of one to six dots, which 

must have a domed or rounded surface. To produce a smooth and rounded surface on Braille dots 

or raised patterns, please use ACR mode to achieve the desired effect. The following paragraph 

illustrates a step by step instruction of how to set the ARC mode and produce dome shaped Braille 

dots/patterns. The instruction will use Illustrator as an example. 

 

1. Add Sopt_White swatch and Spot_White2 swatch; refer to 5.3.1 for the detailed instruction to 

add new color swatch. The setting is used for vector graphics. 

2. Select the characters/Patterns and create contour lines. Move the contour lines to a new layer.  

 

 

3. Step 2 Select Object→Path→Offset Path….. 
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4. Step 3 Set Offset to -0.4mm and click OK.  

 

 

5. Apply the Spot_White swatch to the layer which contains the 0.4mm shrink contour lines. 
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6. Select Windows→Attributes 

 

 

7. Tick Overprint Fill in Attributes dialog box 

 
 

8. Repeat step 2~4 to create another layer with the contour lines shrink inwards by 0.2mm. 

 

 

9. Apply the Spot_White2 swatch to the layer which contains the 0.2mm shrink contour lines. 

 



                                           JF-240UV User Manual 

116 

 

10. Select Windows→Attributes 

 

 

11. Tick Overprint Fill in Attributes dialog box 

 

 

12. Save the file as EPS 
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13. Open FlexiPRINT GCC Edition, select Separation and check if the Spot_White and Spot_White2 

channel are created. If not, please check if the two layers with shrink contour lines are created 

in Illustrator. 

 

 

14. Select Printer Options→Spot_White: Underneath, Spot_White2: None, and select Send 
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15. Open Spot Color Settings dialog box→tick Braille Sign and set the print height→Print Mode：

ARC 

 

 

16. The setting is complete 

 

 

Note: Printing process and throughput would be affected if using Multiple layers mode. Choose a 

proper printing mode that is appropriate. 

Note：When the outermost layer of the Braille sign is printed in white (using white color but not 

any other colors as a cover to print on Braille sign), it is suggested to set the Spot_White shrink 

inward by 0.4mm (Spot_White : -0.2) and set Spot_White as standard (Spot_White2: 0), then 

select Print Mode: ARC and tick Full coverage white base printing. 
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5.3.7 How To Create Raised Printing Effect 

1. Open a bitmap file in Photoshop. 

 

 

2. Select “Channels” tag in the panel 

 

 

3. Create a new Channel and name it to be “Spot_White”, then click OK. 
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4. Go to Image→Adjustments 

Note: The Brightness/Contrast, Levels, Curves value determines the raised printing effect. 

Adjust the value according to what printing result you want to create.  

 

Brightness/Contrast         Levels                     Curves 

   

 

5. Save the file as Tiff format (MUST tick Spot Colors) 
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6. Launch Illustrator and open the Tiff format file that just saved.  

 

 

7. Select “Spot White” layer in Layers tag 

 
 

8. Go to Windows→Attributes 

 
 



                                           JF-240UV User Manual 

122 

 

9. Tick Overprint Fill 

 
 

10. Save the file as EPS format. 

 

11. Launch FlexiPRINT and select Separation tag. Make sure “Spot_White” channel is on the 

channel list, and then click Send. 

 

 

12. Step 12 The process is complete. 
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5.3.8 How to set UV Lamp Curing mode for bright color printing 

Apply “Delay Curing” in UV lamp Curing mode can enhance color brightness, and therefore create  

vivid color gamut and glossy effect to the printed images.  

There are five options under UV lamp curing mode, including Normal Curing (Default), Delay Curing, 

Delay Curing 2, Delay Curing 3 and Delay Curing 4. The larger the number, the brighter the color can 

be created under Delay curing mode, i.e. Delay Curing 4 creates greater color brightness than Delay 

Curing 3; Delay Curing 2 creates greater color brightness than Delay Curing, and so on. 

Note：Applying the Delay Curing option will reduce the print sharpness and ink adhesion, please use 

Delay Curing function according to the printing effect that wants to achieve.  

 

How to set UV Lamp Curing mode? 

If your JF-240UV is not equipped with Varnish ink, please apply the following steps. 

Step 1 Launch FlexiPRINT GCC Edition and open VLCD 

Step 2 Select Open → Print Settings → UV lamp Curing mode, select “Delay Curing” and click Save.  

 

 

If your JF-240UV is equipped with Varnish ink, please apply the following steps. 

Step 1 Spot_Varnish→Under color、None 

 

Step 2 UV lamp Curing mode → Delay Curing → Save 
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5.3.9 How to set CorelDraw for Spot White 

 

Step 1 Open the file 

 

Step 2 Windows→ Color Palettes→ Palette Editor…. 

 

Step 3 Select Add  Color 
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Step 4 Select any color from the color bar and create a new palette from the Name dropdown menu. 

 

 

Step 5 Name the new palette to be Spot_White and select Spot from the Treat as. dropdown menu. 
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Step 6 Add a layer2 and fill it with Spot_White 

 

   

 

 

 

 

 

 

Step 7 Right click on blank space of layer2 and tick Overprint fill 
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Step 8 File→Export…. 

 

Step 9 Save the file as .eps format. 

 

 

Step 10 The process is completed. 
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Step 1 Insert the installation disc and go to :\Program Files (x86)\FlexiPRINT 10.5.1 GCC Edition 

E14-29 Usb\Program\GCCJF240UV 

 

 

 

5.4 Tuning And Testing Procedure 

Note: When the buzzer sounds, please check the message on control panel to see how to settle 

the problem. 

Note: if there is an emergency situation that you push the emergency stop button to shut off the 

machine, make sure the problem is eliminated and restart the machine. 

 

5.4.1 Read Factory Settings 

Please obey the following steps to read the parameter settings for first-time use. 

 

1. Open FlexiPRINT GCC Edition, select Printer Control→VLCD and click Test Pattern 

 

 

2. Activate JF-240UV (VLCD) and click Open, select Parameters backup from machine, then 

JF-240UV (VLCD) will automatically read the parameter backup saved in the machine, including 

the parameter of Band Offset, Uni-Bi-Offset-PH Parameters and so on. 
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5.4.2 Introduction of VLCD 

 

 

 

VLCD Description 
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GCC JF-240UV Flatbed (VLCD) Description 

OPEN Enable JF-240UV calibration online connection 

CLOSE Disable JF-240UV calibration online connection 

IP ADDRESS IP address 

SAVE Save IP address settings 

Color Offset Configure print direction, unidirectional indicates printing image from right to 

left, bidirectional indicates image will be printed from right to left, then left to 

right. This setting is to establish the unidirectional / bidirectional precision. 

Uni direction Offset 

 

Print the unidirectional alignment 

calibration pattern chart for print head 

parameter tuning. 

  

Bi direction Offset 

 

Print the bidirectional alignment 

calibration pattern chart for print head 

parameter tuning. 

  

Print Settings 

VWKCMY Open/Close print head channel   

UV lamp curing mode Normal Curing 

Delay Curing 

  

UV Power UV power adjustment  0~100  

Print Speed Level Print speed adjustment Level 1~5  

Enable Static bar Enable the static bar   

Enable job repeat 

function 

Set number of job repeats 1~999   

Enable compensate color offset by print head gap 

Enable job repeat 

function with roll 

media 

Set number of job repeats when printing 

on roll media with roll to roll system 

1~999  

Distances between two jobs Max.: 500mm 

Negative Pressure 

Reset to Zero Reset negative pressure to 0 kap   

Set kpa Negative pressure settings   

Check engine board 

version 

Read engine board version   

Job Ink Use 

VWKCMY /CC/Price/L Check ink consumption and print time of 

a file  

  

PH PARAMETERS Ink jet print head parameter settings 

Channel K、C、M、Y、V、W ink jet head color name   
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Drop/Speed m/s Ink jet head drop speed adjustment   

Default Voltage Ink jet head voltage adjustment   

MACHINE PARAMETERS 

Write Parameters to 

machine 

Send the parameter settings to machine   

Parameters backup 

from machine 

Retrieve parameters backup from 

machine 

  

MB VERSION 

Read Read M/B version info.: 

Motion Firmware Version 

Motion FPGA Version 

Ink ID Board Version 

Engine Board Version 

  

 

 

5.4.3 Preliminary Calibration Parameters 

Set the printing direction. When Uni-Directional is selected, the image will be printed only from 

right to the left; when Bi-directional is selected, the image will first printed from right to left, then 

from left to right. This calibration is primarily used to ensure the uni-directional / bi-directional 

printing precision. 

 

Uni-Directional Calibration:  

1. Start FlexiPRINT GCC Edition, select Color Offset in Printer Control and click Test Pattern. 

 

 

2. JF-240UV will automatically start Color Offset Test Pattern 

 

 

 

 

 



                                           JF-240UV User Manual 

132 

 

3. Select VLCD in Printer Control and press Test Pattern 

 

 

4. Start VLCD and click Open. 

 

 

5. Confirm Color Offset and adjust parameters as shown in the figure below. 

  (Figure 4-62) 
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Following are horizontal alignment calibration examples (please refer to Example 1 and Example 

2):  

 

Note: Please read the following information thoroughly prior you proceed to the inkjet head 

horizontal alignment calibration. 

 

6. Please use K (black) color to calibrate other colors. 

 

7. There are 31 calibration lines on the horizontal calibration pattern chart. Numbers are layout from left to 

right.  Please refer to Figure 4-70, the 16th
P line (0) is the initial number. 

 

8. These numbers will indicate the offset (bias) value for each inkjet head 

 

Example 1: Horizontal alignment calibration for the inkjet head of Cyan color. 

 

 

 

 

Example 2: Horizontal alignment calibration for the inkjet head of Magenta color 

 

 

 

Step 1.  Enlarge the Cyan calibration test pattern chart to Example 1. Use a magnify lens to 

observe that Cyan line and Black line are aligned at number “1” line. Keep a record on the 

number where two lines are aligned. 
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Step 2. Use a magnify lens to observe that Magenta line and the Black line are aligned at number 

“-3” line (as Example 2), please keep a record on the number where two lines are aligned. 

Step 3. Use the same method to observe and record each color line aligned with Black color line. 

Step 4. After record all the numbers, go to the control interface of “Unidirection Offset「K、C、M、

Y、LC、LM、W、V」” for JF-240UV VCLD software (as shown below) to conduct horizontal 

fine tuning.   

 

In the Example 1: “1” indicates that the horizontal offset for the color Cyan need to be increased 1. 

In the Example 2: “-3” stands for that the horizontal offset for the color Magenta need to be 

decreased 3. 

For example: M=94-3=91 (Enter 91 in JF-240UV (VLCD)  

C=63+1=64 (Enter 64 in JF-240UV (VLCD) 

 

 

Step 5. Use the same approach to calibrate other inkjet heads. 

Step 6. Use this method to enter the offset values for all the inkjet heads (as shown below), then 

press Save to update the settings.  
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Bi-Directional Calibration: 

1. Start FlexiPRINT GCC Edition, select Bidirection Offset in Printer Control and click Test Pattern. 

 

 

2. JF-240UV will automatically start Bidirection Offset Test Pattern 

 

3. Select VLCD in Printer Control and press Test Pattern. 

 

 

4. Start VLCD and click Open. 
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5. Confirm Bidirection Offset and adjust parameters as shown in the figure below. 

 

 

Note : Please read the following information thoroughly prior you proceed the inkjet head 

bi-directional alignment calibration. 

 Offset unit : 1 line = 0.0705mm (1 inch / 360 DPI = 0.0705) 

 

Example 1: Bidirectional alignment calibration for the inkjet head of Cyan color. 

 

 

 

Example 2: Bidirectional alignment calibration for the inkjet head of Magenta color. 

 

 

First pass: printing from 

right to left. 

Second pass: printing 

from left to right. 
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Step 1.  Enlarge the Cyan calibration test pattern chart to Example 1. Use a magnify lens to 

observe that Cyan line and Black line are aligned at number “1” line. Keep a record on the 

number where two lines are aligned. 

Step 2.  Use a magnify lens to observe that Magenta line and the Black line are aligned at number 

“-3” line (as Example 2), please keep a record on the number where two lines are aligned. 

Step 3.  After record all the offsets for all the colors, go to the control interface of “Bidirection 

Offset 「K、C、M、Y、W、V」” for JF-240UV VCLD software to conduct bidirectional 

calibration. 

 

 

In the Example 1: Cyan line shift 1 line to the left indicates that the bidirectional offset for the color 

Cyan need to be increased 1. In the Example 2 : Magenta line shift 3 line to the right stands for that 

the horizontal offset for the color Magenta need to be decreased 3. 

For example: M=12-3=9 (Enter 9 in JF-240UV (VLCD) 

    C=12+1=13 (Enter 13 in JF-240UV (VLCD)  

 

Step 4.  Use the same approach to calibrate other inkjet heads. 

Step 5.  Use this method to enter the offset values for all the inkjet heads, then press Save to 

update the settings. 
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Chapter 6 Maintenance And Basic Service 

This chapter provides the basic maintenance information for the JF-240UV flatbed printer (i.e. clean 

up operations for the flatbed printer). Other than the operations described here, the rest of the 

service must be carried out by trained maintenance professionals. 

To keep the flatbed printer in the best performance and the best printing quality, it is necessary to 

periodically clean / maintain this equipment with appropriate procedures. 

6.1 Check Remaining Ink and Refill Ink 

6.1.1 Check Remaining Ink 

 1. Select MENU on the control panel. 

 2. Select INK REMAININNG  

 3. Check remaining ink 

                        

 

Description: 

*Green light indicates high ink level. 

* Yellow light indicates medium ink level. 

* Red light indicates low ink level, ink should be refilled immediately. 
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6.1.2 How To Replace Bulk Ink 

When running out of ink, control panel will show “Ink run out” to remind users to refill the ink. 

Please make sure the color of the ink bottle label matches the ink color you want to refill.  

It is suggested to horizontally shake the White ink 15 times before filling in the bottle or stir the 

White ink manually before printing. 

  

 

Note : Be caution when replace the ink bottle: 

1) Please install the ink bottle to the position according to the color label. 

2) Please fill the ink slowly to prevent the ink from overflowing. 

3) Must be replaced with ink bottle of the same type. 

4) Do not use the uncertified ink bottle. 

5) Do not pull out the ink bottle while the equipment is printing. 

6) Please do not remove the empty ink bottle until a new one is inserted 

 

Warning: Do not store ink, flush cleaning solutions or liquid drained out at any following 

locations. 

Area might be exposed to flame, to avoid fire hazard.   

Area might be exposed to high temperature. 

Area exposed to bleach, any oxidant or explosive materials. 

Area might be reached by children to prevent health hazard. 
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6.2 Daily / Weekly / Monthly Maintenance 

6.2.1 Ink Print Head Cleaning 
Note：Do not use the printhead cleaner to clean the waste ink area 

  

Required daily cleaning:  

Check whether the print head in good condition. It is required to use sponge swabs with Cleaner 

(26501007G) to clean print head, print head area and wiper everyday. 

Note：Switch the ink valve off while cleaning, and switch the ink valves on after the process is 

complete. 

Print Head Cleaning  

 1. Select MENU on the control panel 

2. Select MANUL CLEANING  

 3. Select ENTER, press PURGE button and wait for 20 seconds, then press  

4. Remove thumbscrews and open the left cover and close ink valve.  
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5. Use sponge swabs with cleaner to clean the area underneath the print heads, and wipe residues 

from back to front. 

Note: Do not reuse the sponge swabs.  

Note: The change of color of sponge swab does not affect its function. 

 

6. Open ink valve, close up the left cover and fix it with thumbscrews, and press  

  

 

 

Required weekly maintenance:  

Check whether the print head is in good condition. It is required to use sponge swabs with Cleaner 

(26501007G) to clean print head and print head area every week, and make sure that ink bottle is 

not empty and dispose waste ink bottle. 

 

 

Thumbscrew 

Cover 

Thumbscrew 

Cover 
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6.2.2 How To Turn On/Off POWER SAVE Function 

  

The function of POWER SAVE is to save energy. When the device idles longer than a set period of 

time, JF-240UV will automatically enter POWER SAVE mode. 

Select POWER SAVE on the control panel to activate POWER SAVE and press it again to deactivate it. 

There are five time interval setting, 15 sec., 30 sec., 1 min., 3 min. and 5 min, user may choose 

whichever is suitable.  

6.2.3 How To Dispose Waste Ink Bottle  

When the waste ink bottle is full, control panel will display “Waste ink bottle is full” message. It is 

recommended that remove the waste ink bottle and dispose the waste ink to a waste ink collecting 

area. 

Dispose the waste ink according to the following steps: 

 1. Select MENU on control panel 

 2. Select MAINTENANCE  

3. Select REPLACE WASTE INK BOTTLE 

4. Remove the waste ink bottle 

     

 

5. Install the empty waste ink bottle 
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NOTE:  

Waste ink bottle contains hazardous substances. Please DO NOT dispose the waste ink bottle with 

general garbage or discard it into sewage treatment system.   

Please follow the local regulations to dispose the waste ink to prevent contaminating the 

environment.  

 

 

 

6.2.4 Cleaning 

Warning: Do not use gasoline, alcohol, or solvent … etc. flammable materials, as they are abrasive 

and hazardous, and could damage the equipment. 

Note: Please make sure power and ink valve are turned off and JF-240UV is done the printing job 

before cleaning process starts. 

Press the clip of ink valve to switch the ink valve off. 

      

Ink valve is opened      Ink valve is closed 

     

Note: When the machine is in printing, the moving parts might cause injury or high temperature 

components might cause burns.  

While in cleaning up process, please clean up ink residue or printing media on the platform 

and other area to avoid deposition. Use cloth moistened with diluted mild cleaning solution or 

water to wipe it out. 

Note: it is advised to clean the capping area with cleaning cloths every week 
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6.3 Print Head Maintenance And Clean Up 

Print head maintenance and clean up are important to ensure machine printing quality. Generally it 

can be divided into daily maintenance and periodically maintenance. 

Required daily maintenance: Apply automatic basic cleaning up maintenance. 

Required weekly maintenance: Apply automatic advanced cleaning up maintenance. 

Required monthly maintenance: Apply automatic advanced cleaning up maintenance, and wipe the 

print head with cleaning swabs. 

 

Note: When the machine idle 2~3day and the print head nozzle clog, please click Powerful Clean 

to flush it (each Powerful Clean process will take 8 min to complete the cycle). 

Note: When the machine is power-down longer than 7 days, please fill flushing solution into print 

head and drain the ink out, leaving the flushing solution in print head only. 

 

6.3.1 Maintenance And Clean Up 
Step 1 Remove thumbscrews and open up the right cover. 
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Step 2 Remove the tool carriage cover. 

       

 

 

 

 

 

Step3 Press the clip of ink valve to close it and turn off the machine. 

         

Step4 Switch on the ink tube  

Thumbscrew 

Cover  
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Step5 Take in cleaner (26501007G) in syringe. 

       

 

 

 

 

 

 

 

 

Step6 Inject cleaner (26501007G) into ink tube of print head 
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Step 7 Switch off the ink tube 

       

 

Step 8 Close the tool carriage cover.  

       

  

Step 9 Complete 

 

 

 

 

 

 

 

 

6.3.2 Maintenance And Clean Up For Print Head of White Ink 

When the machine is power-down longer than 7 days or print head nozzle of white ink clogged, 

conduct the following steps before printing. 

Step 1 Turn on the power. 
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Step 2 Remove thumbscrews and open up the left cover.  

 

  

Step 3 Remove the tool carriage cover. 

      

 

 

 

 

 

 

Step 4 Press the clip of ink valve to open it 
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Step 5  

 1. Select MENU on the control panel. 

 2. Select CLEANING 

3. Select WHITE CIRCULATION, then JF-240UV starts WHITE CIRCULATION. 

 

Step 6 After WHITE CIRCULATION is done, continue to CLEANING process according to following 

steps 

  1. Select MENU on the control panel 

   2. Select CLEANING 

  3. Select POWERFUL 

 

 

 

 

Step 7 Close the tool carriage cover.  
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Step 8 Close left cover and fasten it with thumbscrews.  

 

Step 9 Complete  

 

6.3.3 Automatic Basic Cleaning Up Maintenance 

For the daily cleaning up and maintenance, if the print head is clogged, it is recommended to apply 

basic cleaning up instruction procedure to clean up print head prior the print job. 

 

Step 1 Perform NOZZLE CHECK 

 1. Select MENU on the control panel 

2. Select NOZZLE CHECK 

3. Enter X, Y value and press ENTER 

  

 

Step 2 JF-240UV will print out Nozzle Check test pattern, if the printing quality is similar to the 
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figure below, please clean it up according to the following steps. 

 

Step 3 

 1. Select MENU on the control panel 

2. Select CLEANING  

3. Select NORMAL, and the machine will carry out automatic basic cleaning up procedure. 

  

Step 4 Repeat step 1~2 to confirm whether the basic cleaning can meet the required printing quality. 

If blocked area are filled, then the basic clean up is completed. 

   

 

 

6.3.4 Automatic Advanced Cleaning Up Maintenance 

For the periodically cleaning up and maintenance, if there is serious blockage in the print head, it is 
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recommended to apply advanced cleaning up instruction procedure to clean up print head prior the 

print job.  

  

Step 1 Perform NOZZLE CHECK 

 1. Select MENU on the control panel 

2. Select NOZZLE CHECK 

3. Enter X, Y value and press ENTER 

 

 

Step 2 JF-240UV will print out Nozzle Check test pattern, if the printing quality is similar to the 

figure below, please clean it up according to the following steps. 

 

 

 

Step 3 
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 1. Select MENU on the control panel 

 2. Select CLEANING 

 3. Select POWERFUL, and JF-240UV will carry out automatic advanced cleaning up 

procedure. 

 

4. Reconfirm whether the advanced cleaning can meet the required printing quality. 

          

Step 4 Repeat step 1~2 to confirm whether the advanced cleaning can meet the required printing 

quality. If the blocked area is filled, then the advanced cleaning is completed. 
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6.3.5 Manual Maintenance 

Manually clean up the print head, based on your usage frequency, conduct manual clean up 

periodically. 

Note: Some reminders for manual clean up procedures: 

1)  Before the manual clean up, please remove any media on the JF-240UV printing platform. 

2)  Don’t use any tool other than the cleaning swab, as it might damage the print head.   

3)  Don’t use the cleaning solution which used to soak the print head or cleaning solution which 

already has been used to clean up the print head.  It could lower the cleaning efficiency. 

4)  For the manual cleaning, please move very slowly and use the minimal force, don’t rub, wipe, 

scratch, or crash the print head.  

* If the print head is damaged, please replace with a new one to ensure printing quality. For the 

wiper purchasing, please contact the GCC authorized distributors. 

Step 1 Use cloth to clean up the area with ink residue 

  

Step 2 

 1. Select MENU 

2. Select MANUL CLEANING  

 3. Select ENTER (The cartridge will move to maintenance area on the left side) 

Step 3 Remove thumbscrews and open up the left cover 

   

Thumbscrew 

Cover 
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Step 4 Press Purge switch for 3 seconds and wait for 20 seconds, then press  and close ink 

valve.  

 

Step 5 Dip the cleaning swab into the cleaning solution bottle to moisten it. 

                

Step 6 Check carefully if there are any residues of ink left on the area underneath the print heads.  

  

Step 7 Use sponge swabs to clean the area and wipe residues from back to front.  

 

Step 8 Open ink valve, close up the left cover and fix it with thumbscrews and select . 

 
 

Thumbscrew 

Cover  

Be sure to clean using 

One of the included 

Cleaning sticks. 
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6.4 How To Replace The Filter and Glass Surface Of LED Lamp 

Note: It is suggested to change the filter of LED lamp every six months. 

Step 1 

 1. Select MENU on the control panel 

  2. Select MAINTENANCE 

 3. Select REPLACE LED LAMP. 

 

Step 2 Remove the thumbscrews and open the right cover. 

  

 

Step 2 Turn off all ink valves. 

 

Step 3 Turn off the power and unplug the power cord. 

 

Screw 

Cover 
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Step 4 Disconnect the Led Lamp wire.  

  

 

 

 

 

Step 5 Take apart the screw at the upper position which is connected with Led lamp set. 

 
 

Step 6 Take apart the screws at the side position which is connected with Led lamp set. 

 



                                           JF-240UV User Manual 

158 

 

Step 7 Take apart the screws (2 pieces). 

  

 

 

 

Step 8 Replace a new led lamp filter and fasten the screws. 

 

 

Step 9 Please use a sponge swabs moistened with alcohol to clean the glass surface of the LED lamp. 

 

Step 10 Follow the procedures in reverse order from step 8 to step 5 to assemble the Led lamp. 
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Step 11 Plug in the power cord and restart JF-240UV. The process is done. 

 

 

 

 

 

 

 

6.5 Ink Drain Away 

Step 1 Remove thumbscrews and open the left cover. 

  

 

 

 

Step 2 Turn on all ink valves. 

Thumbscrew

s 

Cover 
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Step 3  

 1 Select MENU 

  2 Select MAINTENANC 

 3 Select INK INSTALL/DRAIN 

4 Select INK DRAIN AWAY 

 

Step 4 Fill flush into flush channel by order of the instruction on control panel to complete the 

workflow of ink drain. 

 

 

Step 5 Ink drain flow: 
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1.Empty waste ink bottle.
2.Open the ink valves of print Head.
ENTER                                   CANCEL

       Start Ink Drain Procedure?

ENTER     CANCEL 

Close the ink valves of ink bottle as 
shown
ENTER                                   CANCEL

Ink purging…

1.Empty the waste ink bottle
2.Open the ink valves of print head
ENTER                                   CANCEL

Flush purging
ENTER                                   CANCEL

Check Flush solution level…

Low flush solution level.
Fill flush solution into flush ink bottle.

1.Use cotton swabs with Cleaner to     
    clean print head and print head area.
2.Empty the waste ink bottle.
ENTER                                   CANCEL

The process is complete
ENTER                                   

adequate ink
inadequate ink

1.Insert the chip of flush solution.
2.Seal the bottle caps.
ENTER                                   CANCEL

 

 

Step 6 Assemble the left cover with thumbscrew. The process is complete. 

  

 

 

 

Thumbscrew 

Cover  
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6.6 Reset Pressure Gauge with Atmospheric Pressure  

Manually adjust the barometer underneath the machine on the left side to reset the pressure gauge 
with atmospheric pressure. 

Step 1 Close all tube clip above print heads 

  

 

Step 2 Open the right side cover (above main ink tank bottles) 

 

Step 3 Remove the plugs at the bottom of air pressure buffer tank, as soon as removed the plug, the 
pump will keep pumping. 
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Step 4 Open the cover of pressure gauge. 

 

 

Step 5 Pressand buttons at the same and hold for 2 seconds. Release after “0Ad” is shown on 

the display and adjust the pressure gauge with andbuttons. 

    

Note: the default setting for pressure gauge is between 3~4 kpa according to local environment. 

Adjust the pressure gauge to optimized value base on the weather condition to prevent ink from 

dripping.  

Step 6 Put back the plug of air buffer tube. 

 

Step 7 Install back the gauge cover and right side cover. 

Step 8 Open the ink tube clip and complete the procedure. 
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6.7 Lubrication of the X Rails 

The procedure of Lubrication: 

Step 1 Power off the machine 

Step 2 Move the carriage rightwards or leftwards to allow the grease being injected. 

Step 3 Inject 1ml of grease to the injection opening inside the linear bearing on both side. 

Note: Lubrication regularly depending on the job loading, recommend on a quarterly basis. 

  

Lubrication Notes 

1. The carriage must move back and forth on one side, while injecting the grease. 

2. Users can apply manual lubrication or automatic lubrication to the Miniature linear rail for 

regular maintenance.   

3. There should always be lubricant coated on the surface of the rail. 

4. Apply the lubrication again before the oil changes color due to corrosion. 

  

Lubrication Intervals 

1. The length of lubrication interval depends on the working environment, loading and pressure 

bearing condition. The length of the lubrication interval varies, and the safe lubrication 

intervals can only be known after careful observation. 

2. Lubrication interval should not exceed one year. 
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6.8 How to replace alignment rule 

Step 1 Use cross screwdriver to remove the screws on the alignment rules on X and Y axis. Replace  

      the thin alignment rule by the thick one and fix it. 

 

 

Step 2 the replacement of the alignment rules  is complete. 
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Chapter 7 Caldera Installation 

7.1 Caldera Installation 

Recommended System Requirements 

Linux OS : Official Debian 8.6 Jessie (Mate desktop) 

CALDERA Debian 2 (however APPE3 – no APPE4) 

Processor : Intel Core i3, i5 or i7. 

RAM : 4GB or 8GB (recommended), minimum 1GB per core, recommended at least 2 GB per core 

HDD : 250GB 

Monitor / Videocard : 1280×1024 minimum resolution 

 

7.1.1 How to set GCC JF-240UV Driver 

Step 1 Install GCC-JF-240UV calpatch 
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Step 2 Enter the password: caldera 

 

 

Step 3 Click Next 
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Step 4 Click OK and the installation is complete. 

 

 

7.1.2 Launch Caldera RIP 

Step 1 Click Caldera RIP Icon 
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Step 2 Select the file you want to use. 

 

 

Step 3 Move the selected file to the GCC-JF-240UV window. 
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Step 4 Edit the file in Main window and then click Print. 

 

 

Step 5 Caldera will automatically create a file folder named “GCC JF-240UV” under /home/public 

and save the RIP file in the folder. Go to /home/public/GCC-JF-240UV and copy all RIP files to USB 

flash drive. 
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Step 6 Launch FlexiPRINT on your computer/laptop. 

 
 

Step 7 Go to Job Property→Printer Control, select VLCD from dropdown menu and click Test 

Pattern. 
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Step 8 Click Add job 

 
 

Step 9 Click Send job and the process is complete. 
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Chapter 8 Reference Parameter Settings 

The following reference parameter is used on GCC verified materials. 

GCC JF-240UV Reference Parameter (General Material) 

NO Material Print Mode Print Color Directional 
LED  

Power 
Primer 

1 PVC Foam board (3mm) Quality  YMCK Bi-Directional 100% No 

2 Acrylicd (3mm) High Density YMCKW Bi-Directional 100% Yes 

3 ABS/PC (10mm) Quality  YMCKWV Bi-Directional 100% No 

4 

Wood (70mm) 

pencil, pen container, 

wooden product 

Quality  YMCKW Bi-Directional 100% No 

5 Plywood (50mm) Quality  YMCK Bi-Directional 100% No 

6 
Gold foil paper (0.8mm) 

packaging 
High Density YMCKWV Bi-Directional 100% No 

7 
Aluminium Composite 

Material (3mm) 
Quality  YMCK Bi-Directional 100% Yes 

8 
Corrugated sheet, PP 

(3mm~5mm) 
High Speed YMCK Bi-Directional 100% Yes 

9 
Aluminium-magnesium 

alloy (10mm) 
Quality  YMCK Bi-Directional 100% Yes 

10 PET (0.2mm) High Density YMCKW Bi-Directional 100% Yes 

11 
Aluminum foil (OPP) 

(0.25mm) 
Quality  YMCKV Bi-Directional 100% Yes 
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GCC JF-240UV Reference Parameter (For Foil Stamping) 

                                  V：Varnishing and foiling accepted 

                                        ◎：Varnishing only 

Material  (Coating) 
Print Mode Note 

Foil Sleeking Mode Super Gloss Mode  

1 Coated Paper V V  

2 Hannoart Silk V V  

3 Magno Gloss V V  

4 Gold Pearl Classic Linen V V  

5 Starwhite V V  

6 Majesty Chameleon V V  

7 
Bright white Classic 

Columns 

V 

 
V  

Material  (Uncoating) Foil Sleeking Mode Super Gloss Mode Note 

1 Solar White Classic Linen V V 
 

2 Neenah Blotter V V  

3 Neenah Classic Stipple V V  

4 Solar White Classic Laid V V  

5 Solar White Classic Crest V V  
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Appendix A: JF-240UV Specification 

 

Model JF-240UV JF-240UV (blower version) 

Printing method On-demand Piezo head 

Print head (Drop size) Konica KM512 (4pl) 

Printing area (W x L) 24 x 20 in. (609.6 x 508 mm) 

Max. media size 

(W x L x H) 

Sheet 25.6 x 21.7 in. (650 x 550 mm) 

Height  11.8 in. (300 mm) 6.7 in. (170 mm) 

Weight Less than 15 kg 

Print head adjustment Auto Media Calibration (AMC™) 

Speed High Speed: 5.78 m2/hr (720 x 1,440 dpi) 

Quality: 3.9 m2/hr (720 x 1,440 dpi) 

High Density: 1.91 m2/hr (1,440 x 1,440 dpi) 

Ink cartridges Type UV curable ink 

Capacity 1 Liter 

Colors CMYK / CMYKWV CMYKWV 

Ink curing unit Dual UV LED Lamp 

Printing resolutions 1440 x 720dpi、1440 x 1440dpi 

Z movement Motorized 

Hold down force Vacuum table Blower* 

Control Panel Touch Screen (480 x 272 resolution) 

Interface Ethernet 1000BASE-T 

Distance Accuracy – When 

printing 

Error of less than ±0.3% of distance traveled, or ±0.3mm (0.01 

inch), whichever is greater 

Voltage requirement 115/220VAC  50/60HZ 

Power consumption-Operating 115V AC (60HZ) (Max. 270W) 

220V AC (50HZ) (Max. 260W) 

Power consumption-Stand by 115V AC (60HZ) (Max. 160W)  

220V AC (50HZ) (Max. 200W) 

Environment 22℃-30 ℃ (71.6℉- 86 ℉) / 40%-60% humidity 
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(Temperature/Humidity) 

Dimension (W x L x H) 1,760 x 1,160 x 1,140 mm 

69.3 x 45.7 x 44.9 in. 

Weight 200kg 

Optional 

Rotary attachment V V 

Roll to Roll system V X 

Fume Extraction Unit V V 

Static Eliminator Bar V V 

*JF-240UV (for blower) model requires a blower to generate the hold down force. The 

recommended specification of a blower is as below: 

Power Input: 750 Watts 

Flow Rate:  6.5~8.0 m3/min (Air Volume) 

Static Pressure: 375~500 mmAq 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Please visit GCC club for the latest user manual download. GCC reserve the right to modify the user manual without 

notice. 


